Sage 100 Contractor 2016
(formerly Sage Master Builder)
Installation and License Administration Guide
Canadian Edition
Version 20.2
Contents

Pre-installation information ................................................................. 41
Setting up Sage Construction Anywhere Integration .............................. 42
Setting up an API security group and an API user in Sage 100 Contractor .... 42

Chapter 6: Managing Your License ......................................................... 45
  License administration ................................................................. 45
  Managing licenses ....................................................................... 52
  Troubleshooting license issues ...................................................... 52

Chapter 7: License Use and Sage 100 Contractor ................................. 55
  Specify Sage License Server .......................................................... 55

Chapter 8: Special Configurations—Operating Systems and Services .... 57
  Windows 8.1 Professional and Server 2012 Standard Operating Systems .... 57
  Windows 7 Professional and Server 2008 R2 Standard Operating Systems .... 58
  Windows 7 and Server 2008 Operating Systems .................................. 60
  Citrix and Terminal Servers .............................................................. 61
  Backing Up Your Data .................................................................... 62
  Configuring Windows Regional and Short Date Format ......................... 63

Index ................................................................................................. 65
Chapter 1: Welcome to Sage 100 Contractor Installation

Welcome to Sage 100 Contractor installation. Sage 100 Contractor can run in many different software and network environments, with implications you need to consider as you prepare to install the software. The more you understand about the installation process and how it relates to your software and network environment, the more likely your installation will proceed smoothly.

This chapter provides more information about customer resources, such as:

- Other printed and printable guides
- The user-assistance Help system
- Contacts for Customer Support
- Sage 100 Contractor training
- Information about business partners.

How to read this document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in **bold type**.
- Information you enter into the software is in bold type, as in the following example:
  
  Enter *Miscellaneous* in the *Amount Type* box.

- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, SHIFT + TAB.

- The names of buttons you can click with your mouse are enclosed in bold type; for example, [**OK**] and [**Post**].

**TIP:** This symbol draws your attention to helpful information to make it easier for you to use Sage 100 Contractor.

**NOTE:** This symbol draws your attention to information of particular interest, such as information not included in steps.

**CAUTION:** This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

**IMPORTANT:** This symbol draws your attention to information that is of critical importance.
Customer Support and resources

IMPORTANT: Before you contact the Customer Support Call Center, take advantage of the following resources, which are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help

From anywhere in the Sage 100 Contractor software, you can display this comprehensive library of accessible topics to learn more about specific procedures, topics, fields, or buttons.

Product documentation

The software comes with several PDF guides, including Release Notes, Installation and License Administration Guide, and User Guide, among others.

To view the guides, click Home & Resources tab > Product Documentation or, if you have Activity Centers hidden, click Resources > Printable Documentation.

Sage Knowledgebase

Depending on your Sage service plan, we offer a web-based Sage Knowledgebase and online user community forums at www.na.sage.com or through the in-product menu. Our staff maintains an extensive knowledge database of questions and answers covering everything from frequently asked questions to more complex problems and solutions. In addition, we keep all product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer your call.

To log in to the Sage Knowledgebase:

1. Go to https://support.na.sage.com/.
2. In the upper-right section of the page, above the Search, click Login.
3. Enter your Customer Portal Username and Password.
4. Click Log on.

Contacting Customer Support

Depending on your Sage service plan, you may be able to contact the Sage Customer Support Call Center to work with one of our highly trained customer support professionals. The Knowledgebase article How do I get technical support for Sage 100 Contractor? provides contact information and hours of operation, and it can help you to determine which service works best for you.

Our analysts work with you to respond accordingly to the urgency of your issue.

Call urgency can range from a simple explanation of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls may warrant further research and followup, in which
case our support analyst will place your call in his/her in-progress work list. At every step of the way, we work with you until we reach a resolution or agreement.

Depending on your Sage service plan, you may check the status or update, or even create a new support ticket online:

1. Visit **www.na.sage.com**.
2. In the upper-right section of the page, above the Search, click **Login**.
3. Enter your Customer Portal **Username** and **Password**.
4. Click **Log on**.
5. On the right, select **Submit a customer support case**.

**Before you call customer support**

Be sure to have the following information on hand so we can handle your call efficiently.

<table>
<thead>
<tr>
<th>Question</th>
<th>How to Find the Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is your Sage client ID number?</td>
<td>Your client ID number can be found on correspondence you receive from Sage. If you do not know your Sage client ID, contact the person at your company who maintains your relationship with Sage.</td>
</tr>
<tr>
<td>What software version are you using?</td>
<td>To find the version, open Sage 100 Contractor; click <strong>Help &gt; About Sage 100 Contractor</strong> and note the number listed.</td>
</tr>
<tr>
<td>What application or area in the software are you calling about?</td>
<td>On the menu list, identify the application and window where are you are working (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).</td>
</tr>
<tr>
<td>How can we help you?</td>
<td>Walk through the exact steps you completed with as much detail and accuracy as possible.</td>
</tr>
<tr>
<td>Is there an error message?</td>
<td>Write down the exact wording of the message.</td>
</tr>
<tr>
<td>Can you reproduce the issue?</td>
<td>Were you able to walk through the same steps that led to the problem and see whether it happened again?</td>
</tr>
<tr>
<td>Is this the first time the problem has happened? Does the problem occur on one workstation or several?</td>
<td>Ask other users if they have experienced the same problem. Have them test at their workstation to see if they experience the same problem. Also, have the original user try other workstations to see whether the problem is specific to that user.</td>
</tr>
<tr>
<td>Question</td>
<td>How to Find the Answer</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Has anything changed with your software, hardware, or workflow?</td>
<td>Ask your network administrator for technical information regarding anything that may have changed behind the scenes: upgrades to Sage 100 Contractor, new third-party software installations, moving of data from one server to another, new printers or print driver installation, or anything else that might affect the network.</td>
</tr>
<tr>
<td>Does the problem happen in the sample data sets?</td>
<td>Select [File&gt; Open Company], then change the drive letter on the dropdown to C:, select Sample Company.</td>
</tr>
<tr>
<td>What kind of network are you using?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>What printers and print drivers are installed?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>When was your last backup?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
</tbody>
</table>

**Training resources**

When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage 100 Contractor to support your business. Contact your business partner to find out about training options or visit Sage University at [http://www.sageu.com](http://www.sageu.com).

**Online classes**

Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient training option for your company and new users to learn more about Sage 100 Contractor so you can get the most out of the software. You can select from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor. During the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online live session, you can ask questions and benefit from hearing answers to other students’ questions.

For more information, visit [http://www.sageu.com](http://www.sageu.com).

**Getting started as a new user**

We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For more information, visit [http://www.sageu.com](http://www.sageu.com).
Business partners

To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of business partners. Business partners have local expertise and regional knowledge working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation, implementation, and training. They’re fully equipped to help you get where you want to be. For more information, contact your Sage 100 Contractor business partner.

The Users Group

TUG, The Users Group for Sage 300 Construction and Real Estate, Sage 100 Contractor, and Sage Estimating is a not-for-profit, professional organization committed to supporting the users of Sage 100 Contractor and other Sage construction software.

You can find out more about the group, their services, and how to become a member at http://tugweb.site-ym.com/default.asp.

Business forms

Sage 100 Contractor is designed to work with generic cheques and forms that are available from many sources. There is no single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and cheques through Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.
Chapter 2: System Configuration

This chapter presents technical information about how to configure Sage 100 Contractor for specific operating systems.

For current information about supported operating systems, Internet browsers, and other software, and about system requirements for servers and client workstations, refer to our Knowledgebase article ID 67758, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=67758.

Make sure your computers meet the system requirements before you install the software. Sage 100 Contractor may not run properly or at all on computers that do not meet the minimum requirements.

About installing and configuring Microsoft SQL Server

Sage 100 Contractor 2016 requires an instance of Microsoft SQL Server or Microsoft SQL Server Express.

If you do not already have a SQL Server instance, you can choose to download and install SQL Server Express when you open Database Administration for Sage 100 Contractor. If you do so, the installation program configures a SQL Server instance with optimal settings for running Sage 100 Contractor.

You must install Database Administration on the same machine on which you install SQL Server or SQL Server Express.

If you already have an instance of SQL Server installed, and you want to use it for your Sage 100 Contractor company, Database Administration will attempt to configure this instance for you when you connect.

**IMPORTANT:** For tighter security, we strongly recommend that you create a SQL Server Instance exclusively for Sage 100 Contractor databases, ensuring that only approved applications have access to the SQL Server database.

**.NET 4.5 Framework is required**

If Microsoft .NET 4.5 Framework is not already installed, it will be installed automatically when you install Sage 100 Contractor. Installation of .NET 4.5 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both Sage 100 Contractor software and .NET 4.5 Framework.

**IMPORTANT:** If Sage 100 Contractor requires an installation of .NET 4.5 Framework, the Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is completed. If you are prompted to restart your computer after the .NET Framework installation, you must do so to continue the Sage 100 Contractor installation.
Installation of Database Administration on a domain controller is not allowed

SQL Server is not supported on a domain controller. If you attempt to install Database Administration on a machine used as a domain controller, you will receive an error message.

For more information see the Microsoft Knowledgebase article https://support.microsoft.com/en-us/kb/2032911.

Internet access required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or e-filing tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_requirements.htm.

Network configuration and licensing

About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:


- TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.

- Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.
Configuring Sage 100 Contractor Hosting Framework TCP port number

Sage 100 Contractor uses the TCP starting port number 48750 as the default. You can configure the port number using the XML file Sage.CRE.HostingFramework.Service-InstanceConfig.xml, located in the Programs (x86)\Sage\Sage 100 Contractor folder.

If you need to change the default port numbers for the Sage 100 Contractor Hosting Framework using the Sage.CRE.HostingFramework.Service-InstanceConfig.xml file, you must change it on every computer on the network where Sage 100 Contractor is installed. In addition, after making this change, the Sage 100 Contractor Hosting Framework on each computer running Sage 100 Contractor must be restarted.

**NOTE:** Consult your IT administrator for alternative port numbers.

**To change the port numbers:**

1. In Window Explorer, locate Sage.CRE.HostingFramework.Service-InstanceConfig.xml in the path Programs(x86)\Sage\Sage 100 Contractor.
2. Right-click Sage.CRE.HostingFramework.Service-InstanceConfig.xml, then open it with a text editor, such as Notepad.
3. Near the end of the file, between the `<StartingPort>` `<StartingPort>` tags, locate the port number.
4. Change the port number.
5. Save, and then close the file.

Repeat these steps on every computer running Sage 100 Contractor.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

**To configure the Windows Firewall:**

1. For Windows Server 2008, click **Start > Control Panel > Security**.
   For Windows 7, click **Start > Control Panel > System and Security**
   For Windows 8.1, click **Start > All apps > Control Panel > System and Security**.
2. Open **Windows Firewall**, and then select **Allow a program or feature through Windows Firewall**.
3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selecting **Allow another program**, then browsing to the following path: `\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml`.
NOTE: By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 32-bit
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 64-bit
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
Windows permissions required for Sage 100 Contractor

When you install Sage 100 Contractor, work with your system administrator to configure the Windows-level security that corresponds to the operating system installed on each workstation where Sage 100 Contractor will be used. Without the correct permissions, users may have difficulty operating Sage 100 Contractor.

**CAUTION:** Always back up your data before changing Windows permissions! Setting Windows security incorrectly can adversely affect system operations. Sage is not responsible for problems caused by incorrectly configured Windows settings.

All the directories listed below must have Full Control, Modify, Read & execute, List folder contents, Read, and Write permission. Special permissions are not required.

### Permissions required

<table>
<thead>
<tr>
<th>Windows component/ version</th>
<th>Directories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registry Keys</td>
<td>HKEY_Current_User\Software\Sage</td>
</tr>
<tr>
<td><strong>Windows component/version</strong></td>
<td><strong>Directories</strong></td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| **Windows 8.1 Professional 32-bit** | HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432node\Sage  
HKEY_CURRENT_CONFIG\SOFTWARE\Sage 100 Contractor PDF Export  
HKEY_CURRENT_CONFIG\SOFTWARE\Sage 100 Contractor RTF Export  
\C:\MB7  
\C:\ProgramData\Sage\Sage 100 Contractor  
\C:\Program Files\Sage\Sage 100 Contractor  
\C:\ProgramData\Aatrix Software  
\C:\Program Files\Aatrix Software  
\C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
| **Windows 8.1 Professional 64-bit** | \C:\MB7  
\C:\ProgramData\Sage\Sage 100 Contractor  
\C:\Program Files (x86)\Sage\Sage 100 Contractor  
\C:\Program Files (x86)\Aatrix Software  
\C:\ProgramData\Aatrix Software  
\C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
| **Windows 7 Professional 32-bit** | \C:\MB7  
\C:\ProgramData\Sage\Sage 100 Contractor  
\C:\Program Files\Sage\Sage 100 Contractor  
\C:\ProgramData\Aatrix Software  
\C:\Program Files\Aatrix Software  
\C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
| **Windows 7 Professional 64-bit** | \C:\MB7 \C:\ProgramData\Sage\Sage 100 Contractor  
\C:\Program Files (x86)\Sage\Sage 100 Contractor |
### Windows component/ version

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files (x86)\Aatrix Software</td>
</tr>
<tr>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td>Network location of Sage 100 Contractor data</td>
</tr>
<tr>
<td>C:\MB7</td>
</tr>
<tr>
<td>C:\ProgramData\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td>C:\ProgramFiles (x86)\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td>C:\Program Files (x86)\Aatrix Software</td>
</tr>
<tr>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td>Network location of Sage 100 Contractor data</td>
</tr>
</tbody>
</table>

### Report scheduling and faxing functionality

**About setting up emailing and faxing through Sage 100 Contractor**

Using the faxing functionality through the Sage 100 Contractor program requires:

- Installation of the Windows operating system Fax Service component
- A separate installation and setup of a fax modem in your workstation
- Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that came with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing the Windows operating system Fax Service component, see [Installing the Window Fax Services component](#).

**Upgrade to the latest version of Adobe Reader**

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and install the latest version from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).
Disable automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic “check for updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

**NOTE:** Instructions for disabling automatic “check for updates” differ from version to version of Adobe Reader. Refer to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

**IMPORTANT:** Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple mail transfer protocol (SMTP) email server.

The Email Settings window provides a way for you to set up email. You can change the selections to accommodate different emailing preferences.

You can access the Email Settings window through:

- Any Report Printing window by clicking the Email button on the toolbar to open the Email Distribution windows. Then, click the Email Settings button to open the Email Settings window.
- 7-6 Alerts Manager
- Click on Settings in the Dispatch Board, then click on Email Setup.

Sage 100 Contractor and SMTP

**IMPORTANT:** The SMTP server may be located on your workstation PC, on a server on your company’s network, or at your Internet service provider (ISP). If the email server is local, you may need the assistance of an IT professional to properly identify or set up this capability. If the email server is located at your ISP, you may need contact your ISP for assistance.

Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user authentication” at the SMTP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

- Sage 100 Contractor user name and password
- Network domain user name and password
- Windows system user name and password.

**NOTE:** We do not provide support for setting up or installing an email server. You set up user authentication and your fax line access dial out number on 7-1 Company Information.
Installing the Windows Fax Services component

To fax from Sage 100 Contractor, you must install the Windows Fax Services component:

**Windows 7**

1. Click **Start > Control Panel > Programs > Turn Windows features on or off**.
2. On the **Windows Features** window, locate **Print and Document Services**, then click the **Windows fax and scan** check box.
3. Click [OK].

**Windows 8.1**

1. Click **Start > All apps > Control Panel > Programs > Turn Windows features on or off**.
2. On the **Windows Features** window, locate **Print and Document Services**, then click the **Windows fax and scan** check box.
3. Click [OK].

**Windows Server 2012**

[Detailed information from Microsoft]
Chapter 3: Sage 100 Contractor Installation

This chapter provides detailed information and instructions for installing Sage 100 Contractor software in different environments, such as:

- Single user
- Peer-to-peer
- Network

It also describes how to install the software in a new environment, and how to upgrade the software and your company data from an earlier version.

Installation Overview

This section provides an overview of all the important steps you should complete to install version 20.2. Review it carefully before you install Sage 100 Contractor 2016 and set up your company or migrate your company from version 19.7.

Later sections in this chapter cover installation tasks in greater detail.

**TIP:** Download and print the Quick Start Checklist from our website. Then check off each step on the printed list as you complete the necessary tasks.

**NOTE:** If this is a new installation of Sage 100 Contractor, you do not perform the steps to migrate your data or to "go live" using migrated company data with Sage 100 Contractor 2016.

1. **Review hardware and software requirements**

Verify that the computer on which you plan to install Sage 100 Contractor 2016, and each workstation that requires access to Sage 100 Contractor 2016, meets the minimum system requirements.

For current requirements, see the Knowledgebase article 67758, "System Requirements: Sage 100 Contractor 2016 version 20.2" at: [https://support.na.sage.com/selfservice/viewdocumnt.do?externallId=67758](https://support.na.sage.com/selfservice/viewdocumnt.do?externallId=67758).

**IMPORTANT:** Software not listed in the System Requirements article have not been tested by Sage Software, and are not supported. If you try to use a newer version of the software, or use software not listed, you may encounter technical difficulties.

- Confirm that the Sage 100 Contractor 2016 server meets the minimum system requirements.
- Confirm that each client workstation meets the minimum system requirements.
- Confirm that the server and each workstation meet the minimum software requirements (database, operating system, Microsoft programs, and so on).
2. **Review the Sage 100 Contractor 2016 documentation**

Besides this *Installation and Administration Guide*, you should read and understand the following documentation before you proceed with installation:

- **Sage 100 Contractor 2016 Release Notes** *(U.S.; Canada)*
- **Sage 100 Contractor 2016 Database and Company Administration Guide** *(U.S.; Canada)*

3. **Install and set up Sage 100 Contractor 2016**

1. Install Sage 100 Contractor 2016 on the machine you will use as the license server, choosing the options to install the License Server and Database Administration.

   **NOTE:** If you have been using an earlier version of Sage 100 Contractor, install the license server on the same machine as your version 19.7 license server. Sage 100 Contractor 2016 was designed to co-exist with version 19.7 and share the same license entitlements.

   **IMPORTANT:** Do not attempt to install Database Administration on a domain controller. For more information see the Microsoft Knowledgebase article [https://support.microsoft.com/en-us/kb/2032911](https://support.microsoft.com/en-us/kb/2032911).

   For detailed steps on new installations of Sage 100 Contractor, see “New installations” on page 24.
   For detailed steps on installing an upgrade to Sage 100 Contractor version 20.2, see “Upgrade installations” on page 27.

2. Use the Database Administration tool to connect your company database to Microsoft SQL Server.

   **TIP:** If you do not have an instance of Microsoft SQL Server, click the link to install and configure SQL Server Express.

   For more detailed information about installing and configuring Microsoft SQL Server, see “About installing and configuring Microsoft SQL Server” on page 7.

3. Use the Database Administration tool to deploy the Sample Company data.

   For more information about deploying sample data, see “About deploying the Sample Company” on page 23.

4. If you have been using an earlier version of Sage 100 Contractor, migrate your company from version 19.7.

   Use Database Administration for Sage 100 Contractor to migrate your company to version 20.2. If you have multiple companies, migrate your principal company and complete the remaining tasks on this checklist for that company. Do the same for other companies, later.

   - Use the Database Administration tool to migrate your Sage 100 Contractor company folder from version 19.7.
   - Use the Database Administration tool to migrate your custom reports.
   - Migrate archive companies, as needed. (You can leave your archive companies in version 19.7 if you prefer.)

   For more detailed information about migrating your data, see “Migrating your company data from version 19.7” on page 29.
4. Ensure that company administrators and sysadmin users have administrator rights on the server

Make sure that users who will have company administrator or sysadmin rights in Sage 100 Contractor 2016 also have Windows administrator rights on the server that is hosting your SQL Server database.

**IMPORTANT:** You may need to work with your IT department to accomplish this task.

5. Assign permissions to sysadmin users

Use the Database Administration tool to assign sysadmin rights to at least one other user.

6. Assign permissions to company administrators

In Sage Sage 100 Contractor 2016, use the **7-2-2 User List** to designate company administrators.

If you have been using a previous version of Sage 100 Contractor, designate former supervisor users as company administrators.

**TIP:** See the User List help for tips on copying Supervisor defaults from version 19.7 to company administrators in Sage 100 Contractor 2016.

7. When you and your users are ready, use Sage 100 Contractor 2016 in a production ("live") environment.

**IMPORTANT:** If you have been using a previous version of Sage 100 Contractor, follow the steps in "Ready to "go live" with Sage 100 Contractor 2016?" on page 36 to move your company data to your production environment, migrate scheduled reports and alerts, make sure third-party applications that read and write to Sage 100 Contractor 2016 are connected properly to your new company database, and then stop using version 19.7.

**Pre-installation information for new customers**

To harness the full power of Sage 100 Contractor, you must thoroughly plan the implementation and use of this software in running your business. Before you can start working in the program, you must also transfer your existing company data to Sage 100 Contractor. Your business partner can assist you with a data migration and business implementation plan. For more information about implementing Sage 100 Contractor for your company, see the information about **business partners** in Chapter 1 of this guide.

We recommend that you take advantage of all the knowledge and advice available in Sage 100 Contractor documentation and training classes. We also recommend that you work with your business partner and accounting professionals before you begin to implement this software for your business.

**IMPORTANT:** We recommend that you install the Sage license server on a computer that is always available to other computers on your network that are running Sage 100 Contractor.

**Pre-installation information for existing customers**

As an existing customer working with company information and possibly with scheduled reports, you should review these important points before you install the program.
**IMPORTANT:** To migrate your data from version 19.7 to version 20.2, you must install version 20.2 on the same computer as version 19.7. You should confirm that this computer’s processor, memory, and free disk space are sufficient for a second installation of Sage 100 Contractor plus Microsoft SQL Express. (For current information about supported operating systems, Internet browsers, and other software, and about system requirements for servers and client workstations, refer to our Knowledgebase article ID 67758, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=67758.)

**NOTE:** Before you install version 20.2, make at least one backup, but consider making two backup copies of your existing company data for an extra margin of safety.

### Upgrade Paths

To upgrade to Sage 100 Contractor (SQL), you must first upgrade to version 19.7. The following table shows the upgrade paths from earlier versions.

<table>
<thead>
<tr>
<th>Upgrade From</th>
<th>Upgrade Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.7</td>
<td>Migrate your data to version 20.x using the utility in Database Administration for Sage 100 Contractor</td>
</tr>
<tr>
<td>19.x</td>
<td>Upgrade versions 19.6 and earlier to version 19.7</td>
</tr>
<tr>
<td>18.x</td>
<td>Upgrade directly to version 19.7</td>
</tr>
<tr>
<td>17.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>16.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>15.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>14.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>13.x</td>
<td>Upgrade to 14.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>12.x</td>
<td>Upgrade to 13.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>11.x</td>
<td>Upgrade to 13.x, reindex your data, and then upgrade to 19.7</td>
</tr>
<tr>
<td>10.x</td>
<td>Upgrade to 13.x, reindex your data, and then upgrade to 19.7</td>
</tr>
</tbody>
</table>

### Duration of the installation process

Plan on at least five and possibly up to 20 minutes per computer to install Sage 100 Contractor. The duration of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. For
example, some newer computers come with pre-installed software required to run Sage 100 Contractor software, such as the .NET 4.5 Framework. Installation to older computers may take more time.

If Microsoft .NET 4.5 Framework is not already installed, it will be installed automatically when you install Sage 100 Contractor. Installation of .NET 4.5 Framework alone may take up to 20 minutes per computer, and you may be prompted to restart your computer after the .NET installation.

Also, if you install Microsoft SQL Express when you first open Sage 100 Contractor Database Administration, plan on about 20 minutes to download, install, and configure SQL Express. (You only have to do this one time.)

**Additional required software**

Microsoft SQL Server or Microsoft SQL Express must be installed on the same machine as Sage 100 Contractor Database Administration.

Microsoft .NET 4.5 Framework must be installed on all computers running Sage 100 Contractor software. The installer determines whether .NET 4.5 Framework is already installed, and if it is not, it installs the required software automatically. Plan for an additional 20 minutes per computer to install .NET 4.5 Framework.

**IMPORTANT:** When installing on a server, you should make sure that no other users are logged onto the machine. The Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is finished. If you are prompted to restart your computer after the .NET Framework installation, you must do so to continue the Sage 100 Contractor installation.

**NOTE:** It is very important to understand the network environments and operating systems on the computers and server computers where you install Sage 100 Contractor software. For detailed information about installing to different environments, see [Special Configurations—Operating Systems and Services](https://support.na.sage.com/selfservice/viewdocument.do?externalId=67758).

**About installing the Sage 100 Contractor software to different configurations**

You can install Sage 100 Contractor software to many different configurations, for example, stand-alone, network server, Citrix and Terminal Services servers, peer-to-peer, and workstations.

**IMPORTANT:** To migrate your data from version 19.7 to version 20.2, you must install version 20.2 on the same computer as version 19.7. You should confirm that this computer's processor, memory, and free disk space are sufficient for a second installation of Sage 100 Contractor plus Microsoft SQL Express. For current information about supported operating systems, Internet browsers, and other software, and about system requirements for servers and client workstations, refer to our Knowledgebase article ID 67758, available at [https://support.na.sage.com/selfservice/viewdocument.do?externalId=67758](https://support.na.sage.com/selfservice/viewdocument.do?externalId=67758).

**IMPORTANT:** The optimal operational size of a peer-to-peer network running Sage 100 Contractor is two to five workstations. Additional workstations may adversely impact Sage 100 Contractor response times. Networks consisting of more than five (5) workstations may need to use one computer as a dedicated server.
Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different workstations, users can then access the server to share one set of data, one set of reports, and one set of report forms.

During installation, the installer checks for the components necessary to run Sage 100 Contractor and then copies the program modules and standard reports to the Programs (x86) folder and subfolders on the hard disk. In addition, the installation process copies system files necessary for program operations to the Windows and Windows System folders.

The installation process does not make any configuration changes to the computer. After installation is complete, you must configure the stand-alone computer, server computer, or workstation for optimal performance.

Microsoft SQL Express is not installed when you install Sage 100 Contractor. When you open Database Administration, the connection window provides a link to download and install SQL Express automatically. Alternatively, you can let Database Administration configure an existing instance of Microsoft SQL Server or SQL Express for use with Sage 100 Contractor.

For detailed information about configuring each server and workstation depending on its operating system, see Chapter 8 Special Configurations—Operating Systems and Services.

**Connectivity across your network**

For client workstations to run Sage 100 Contractor, they must all be connected to the Sage license server and to the computer that hosts the SQL Server instance you are using for Sage 100 Contractor.

If only one user sees the “Sage 100 Contractor can’t communicate with the designated Sage license server” message when all other users are connected, you know that the connectivity problem is limited to that one person. If you encounter a hardware failure with your license server, then no one will be able to run Sage 100 Contractor.

**Mapping a network drive to access a company**

You may have to map to a network drive to access a Sage 100 Contractor company if it is not located on a drive on your local computer. Let’s suppose that the company has been moved to network drive Z: Now to access the company data, you have to map to drive Z.

**To map a network drive to access a company:**

1. On your Windows desktop, click Start > Explore.
2. On the toolbar, click Tools > Map Network Drive.
3. On the Map Network Drive window, click [Browse].
4. Locate the drive, and then click [OK].
5. On the Map Network Drive window, click [Finish].
6. On the Company List window, select drive Z.
7. Select the company, and then click [OK].
About deploying the Sample Company

NOTE: We highly recommend that you or your system administrator (if you are not the "sysadmin" user) deploy the Sample Company using the Database Administration for Sage 100 Contractor tool.

The Sample Company provides the means for viewing and working with sample data in Sage 100 Contractor windows. There are sample accounts, sample employees, sample takeoffs, and much more. By viewing and working with this sample data, you can gain an understanding of how different windows interact with the sample data when managing a construction business with Sage 100 Contractor.

Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor training classes.

You can log on to the Sample Company using one of the sample user names. Alternatively, your company administrator can add you as a user to Sample Company so that you can log in using your usual Windows or SQL password.

The Sample Company:

- Allows you a safe way to try out new functions as you learn them.
- Is used in many online and recorded classes.
- Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to understand many concepts.
- Provides starter lists for many values you will need to set up, including cost codes, cost types, tasks, client status, client type, employee positions, paygroups, and so on.
- Provides live data for Sage 100 Contractor reports.
- Takes very little space on your hard disk drive.

NOTE: Deploying or redeploying the Sample Company overwrites any previous installations of the Sample Company. If you have made changes in your Sample Company that you want to keep, rename this folder before installing a fresh copy of the Sample Company.

CAUTION: You should use only Sage 100 Contractor Database Administration to deploy, delete, rename, back up, or restore the Sample Company. The Database Administration tool performs functions necessary to maintain the integrity of your Sage 100 Contractor data, and these functions are not available in SQL Server or SQL Server Express.

Where To Now?

If you are installing the Sage 100 Contractor software on a computer that has never had Sage 100 Contractor installed on it before, refer to the "New installations" on the next page section for instructions on installing and setting up the software for the first time.

If Sage 100 Contractor is already installed on your network computers, refer to the "Upgrade installations" on page 27 section for instructions on upgrading or updating the software.
New installations

By "new installation" we mean installing the software on a computer that has never had Sage 100 Contractor installed on it before.

**NOTE:** Instructions for reinstalling or upgrading an existing installation are different. See Upgrade pre-installation.

You must designate one computer on your network as the Sage license server. This server will manage use of Sage 100 Contractor (for example, the number of people who can use Sage 100 Contractor simultaneously on your network). You must install the software on this computer first, and then activate your licenses before installing Sage 100 Contractor on your other computers.

Copy the entire set of installation files (all files and folder) to a folder that you create on a network drive. Install the program to each client workstation by launching the installation from the network folder from that client workstation. We recommend that you install to the Sage license server computer first. Then, when you install the program to your workstations, you can set up Sage 100 Contractor to find the Sage license server and run the program using your license.

The installation process also presents different installation windows depending on whether you are installing Sage 100 Contractor as the Sage license server or you are just installing Sage 100 Contractor by itself.

**IMPORTANT:** Always start installing the program at the computer that will be your Sage license server, which is likely to be your network server.

**Basic steps for new installations are:**

1. Install the program on your network server, the computer where all your company data is located. You do this only once on your network.
   
   Remember to write down the Sage license server computer’s IP Address and/or computer name, which is displayed at the end of the installation.

2. Activate your licenses.

3. Install the program to all client workstations on your network.

4. From each client workstation, specify the Sage license server.

**Installing Sage 100 Contractor on the Sage license server**

Use these instructions for the following types of installations:

- You are installing Sage 100 Contractor on the computer you will use as the Sage license server in a networked environment.
You are installing Database Administration either in a networked environment, or on a single computer that is not networked with other computers running Sage 100 Contractor (a stand-alone installation).

**NOTE:** You do not need to install Database Administration on the same server as the Sage license server, although this is a practical configuration.

You are installing Sage 100 Contractor on a single computer as a stand-alone installation.

**To install from a download package unzipped into a local or shared folder:**

1. Close all open programs except for firewall and anti-virus programs.
2. Browse to the drive and folder where you downloaded and extracted the software package.
3. In the folder, locate and then double-click the Sage100Contractor_Setup.exe file.
4. Read the instructions on the installation welcome window, and then click [Next] until prompted to select an installation option.
5. On the installation options window, select installation options as follows:
   - Select **Install Sage 100 Contractor** if you plan to run Sage 100 Contractor on the same machine as the license server.
   - **Install server applications:**
     - Select **Database Administration** if you plan to run Microsoft SQL Server (the database server) on the same machine as the license server.
     - Select **License Administration**.
6. Click [Next].
7. On the license agreement window:
   a. Read the License Agreement carefully.
   b. Select the check box to accept the terms.
   c. Click [Next] to continue the installation.
8. If you are prompted to select a product edition, select the edition you want to use, and then click [Install].
   If you are installing the software on a computer where Sage 100 Contractor was installed previously, the same edition is installed. (No prompt appears.)

**NOTES:**
- The installer checks whether .NET 4.5 Framework is installed on the computer, and installs it if this program is not found.
- When installation is finished, a confirmation window displays a list of installed programs, as well as the computer's IP Address and network name.
9. Write down the IP Address and computer name.
Chapter 3: Sage 100 Contractor Installation

**IMPORTANT:** Write down and keep the Sage license server computer’s IP Address and name in a convenient location. To select the Sage license server from client computers running Sage 100 Contractor, you need to select its name from a list or type the computer’s IP Address or name in a text box.

10. Click [Next].

You are prompted to activate your product licenses.

11. Select **Launch the License Administration program**, and then click [Finish].

**TIP:** For information about License Administration, press F1 when viewing that window.

**NOTE:** When Sage 100 Contractor is installed, an icon labeled **SQL License Administration** is placed in the **Sage 100 Contractor** program folder on the Windows Start menu, and a file named Sage.100.Contractor.LicenseAdministration.exe in the Programs (x86)\Sage\Sage 100 Contractor folder. Use them to view license information or update license information for your provisioned license server while on a machine other than the provisioned license server. You can provision additional licenses you have recently acquired to the actual license server machine without having to be present at the actual license server.

**Installing Sage 100 Contractor on client workstations**

**IMPORTANT:** Before installing the software, close all open programs except for firewall and anti-virus programs.

**To install Sage 100 Contractor from a download package unzipped into a local or shared folder**

1. Browse to the drive and folder where you downloaded and extracted the software package.

2. In the folder, locate and then double-click the Sage100Contractor_Setup.exe file.

3. Read the instructions on the installation welcome window, and then click [Next] until prompted to select an installation option.

4. On the installation option window, select **This computer will run Sage 100 Contractor only**, and then click [Next].

5. On the license agreement window, read the License Agreement carefully.

6. Select the check box to accept the terms, then click [Next] to continue the installation.

The installer begins the installation process, checking whether the computer has .NET 4.5 Framework. If this program is not found, the installer installs it.

**NOTE:** When installation is finished, a confirmation window displays a list of installed programs

**The Launch Sage 100 Contractor** check box is preselected so that you can start Sage 100 Contractor and specify the Sage license server.

7. Read the important message, and then follow the instructions to launch Sage 100 Contractor.

8. Click [Finish].
After installing Sage 100 Contractor on a client workstation

After installation, the following icons appear on the Windows Start menu under All Programs > Sage 100 Contractor SQL:

- Database
- License Administration
- Sage 100 Contractor

A file named Sage.100.Contractor.LicenseAdministration.exe is saved in the \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor folder to provide you with the convenience and ability to view license information or update license information for your provisioned license server while on a machine other than the provisioned license server. You can provision additional licenses you have recently acquired to the actual license server machine without having to be present at the actual license server.

Upgrade installations

If you currently have Sage 100 Contractor installed on your network computers and you are going to reinstall it, you could be either upgrading or updating the software.

Upgrade installations involve major changes, enhancements, and fixes to many parts of the program or to modules such as licensing. For example, installing version 20.2 over version 19 is an upgrade because there are major enhancements to the program.

Update installations, in contrast, usually involve changes to specific files, such as the Sage.100.Contractor.PayrollTax.dll file and report forms. These files can be changed and updated without any changes to major parts of the program.

In addition, upgrade installations are different from new installations. During new installations (or reinstalation after completely removing Sage 100 Contractor and Sage licensing), you can designate a computer to be either the Sage license server or a client workstation.

Before you upgrade your Sage 100 Contractor software, you need to complete certain preliminary tasks to ensure the safety of your company data.

**IMPORTANT:** Choose a block of time when you can install the upgrade to all the computers in your office beginning with your Sage license server. Depending on your computer’s hardware and your network configuration, plan on 15 minutes per computer for the installation process alone. Additional tasks may take extra time.

**Before upgrading Sage 100 Contractor:**

1. Back up your company data.
   
   We suggest making two backup copies in case one of them is incomplete, becomes corrupted, or is lost.
2. Exit Sage 100 Contractor and all other programs.
IMPORTANT: You must not install the Sage 100 Contractor upgrade when either Sage 100 Contractor or the Sage 100 Contractor API are running. We recommend that you shut down all other programs when installing Sage 100 Contractor, but you do not have to shut down firewall and anti-virus software.

3. Locate the computer on your network that is your Sage license server, and begin the upgrade installation there.

**Upgrade installation**

Always begin all installations at the computer that is the Sage license server. After installing the upgrade to the Sage license server, install the upgrade to your workstations from the image placed in a folder on the network. For example, if you want to install Sage 100 Contractor to a network drive, you have to go to that computer and install the program from there.

Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access your company data. If you do not change the designation of any computers on your network during an upgrade installation, all client workstations will be able to locate the existing Sage license server again after installation.

**Installing the upgrade**

Use the steps in this section to upgrade your Sage license server computer and your workstation computers.

IMPORTANT: Install the upgrade to the existing Sage license server computer first. Install the upgrade to all workstations only after the license server installation has been completed.

**Before installing the upgrade**

The upgrade installation overwrites the existing Sample Company. If you have made changes in your Sample Company that you want to keep, rename the Sample Company folder before installing the upgrade.

**To install the upgrade from a download package unzipped into a local or shared folder:**

1. Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.
2. Browse to the drive and folder where you extracted the upgrade files.
   Before you proceed with installation, we recommend that you review the Release Notes.
3. Double-click the ReleaseNotes.pdf to open it in your PDF viewer, and then review information about enhancements, program fixes, known issues, and other information that might affect your upgrade installation.
4. Double-click Sage100Contractor_Setup.exe to begin the installation.
5. If you are prompted to allow the program to make changes to your computer, click [Yes].
6. Read the instructions on the installation welcome window, and then click [Next] until prompted to select an installation option.
7. On the installation options window, select installation options as follows:
Select **Install Sage 100 Contractor** on any machine on which you want to run the main application.

**Install server applications:**
- Select **Database Administration** on the single machine that will run Microsoft SQL Server (the database server).
- Select **License Administration** when installing on the machine that will be your license server.

8. Click [**Next**].

9. On the license agreement window:
   a. Read the License Agreement carefully.
   b. Select the check box to accept the terms.
   c. Click [**Next**] to continue the installation.

10. Click [**Next**]. The installation proceeds.

11. On the Installation complete window, click [**Finish**] to launch Sage 100 Contractor.

12. Repeat steps 1 through 11 to upgrade all other computers running Sage 100 Contractor.

**Migrating your company data from version 19.7**

**IMPORTANT:** You must be using Sage 100 Contractor version 19.7 to migrate your company to version 20.2. If you are using an earlier version of Sage 100 Contractor, you must first upgrade your company data to version 19.7.

You use the migration utility in the new Database Administration tool to automatically migrate and upgrade your data to version 20.2, including all company data in folders and subfolders of ...\MB7\[CompanyName].

Migrated files are located in shared folders under \ServerName\CompanyName. These subfolders are organized using a similar folder structure as in earlier versions, and include:

- Aatrix Forms
- Attachments
- Direct Deposit
- Images
- Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100 Contractor. The remaining folders are created as needed.

**NOTE:** For detailed, step-by-step instructions on migration, see the *Database and Company Administration Guide* or the Database Administration help.
Preparing for migration in version 19.7

Migration should proceed smoothly in most instances. However, you should audit your accounting data and your company payroll in version 19.7, and then fix any errors, before attempting migration to version 20.2.

Use the following audit tools to prepare your data in version 19.7:

- 1-6 Period and Fiscal Year Management > Audit Books
- 5-3-7 Payroll Audit
- 6-6-3 Purchase Order Audit
- 6-7-4 Subcontract Audit
- 12-5 Inventory Audit

**NOTE:** If your data includes serious audit errors, you may need assistance from your business partner or consultant to prepare your database for migration.

Migrating reports

The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor reports and reports written with the Sage 100 Contractor report designer.

In version 20.2, shared custom reports and form designs are located in these folders:

- \ServerName\Sage100Contractor\Custom Reports
- \ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated with each user name, as follows:

- \ServerName\Sage100Contractor\User Data\username\Custom Reports
- \ServerName\Sage100Contractor\User Data\username\Report Forms

Updating custom reports

You also need to update custom reports created with third-party software, such as Crystal Reports, so they map to the new database.

We recommend that you use the new report views that come with version 20.2 to create or update reports. The new views were created for your convenience, so that future database changes will not necessarily break your custom reports.

After migrating your company data

After migrating your data, you will likely need to perform the following additional steps to prepare your company for use in Sage 100 Contractor:

**IMPORTANT:** Use Database Administration, not SQL Server Management Studio, for all these tasks.
- **Add company administrators.** There is no longer a generic "supervisor" user as there was in earlier versions. All users must sign into the company using their personal IDs, and only users designated as company administrators have heightened privileges previously associated with the "supervisor" role. You can designate one user as a company administrator during migration, but you can add others later.

- **Add SQL logins for new users.** If you have new users that did not exist in your version 19.7 company, add them as users to the SQL database.

  You must also add them as users and assign security in Sage 100 Contractor.

- **Designate an additional SQL Server administrator.** Only a user with system administrator privileges for the SQL instance can administer users for SQL Server or assign the system administrator role to another user. Therefore, it is vital at all times that more than one user has a system administrator role. If the principal system administrator should suddenly fall ill, or leave your company, or otherwise be unable to perform their duties, another person with administrative access to the SQL Server database must be able to take over that role.

  **NOTE:** The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role in SQL Server. When they designate a SQL Server administrator in Database Administration, that person is also assigned the 'sysadmin' role in SQL Server.

- **Switch your Sage Construction Anywhere to version 20.2.** If you have been using Sage Construction Anywhere with Sage 100 Contractor version 19.7 and want to use it with version 20.2, you will need to switch the connection to version 20.2. For help on switching the connection, see "Switching your Sage Construction Anywhere connection from version 19.7," on page 32.

- **Migrate your Sage ACT! settings to version 20.2.** If you have been using Sage ACT! with Sage 100 Contractor version 19.7 and want to use it with version 20.2, you need to change your ACT! settings to point to your new version 20.2 company database. For help on migrating your ACT! settings to version 20.2, see "Migrating Sage ACT! settings from version 19.7" on page 33.

- **Migrate each user's scheduled reports from version 19.7.** For more information, see "Migrating scheduled reports from version 19.7," on page 35.

- **Migrate each user's alerts from version 19.7.** For more information, see "Migrating alerts from version 19.7" on page 34.

### Changes to converted data

During migration, the program may encounter problems that might prevent it from writing a particular record to the new SQL Server database.

If the problem is one that the migration program can fix, it repairs the record, and then writes the updated record to the SQL Server database. (For a list of the types of errors that can be fixed during migration, see the *Database and Company Administration Guide.*)

**NOTE:** Not all errors can be fixed during migration. In these cases, the record is not written to the new database.

---

**Upgrade installations**
The migration log file

The program keeps a log of all changed records and records that were not migrated because of an unresolvable error, unless the record was invalid in version 19.7. (Invalid records are neither migrated nor logged.)

After migration, you should check the log file to see what changes were made to your data during conversion, or whether any records were not migrated to the new SQL database.

The _SQL_MIGRATION_LOG.TXT file is located in the source company’s main folder (for example, C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more detailed information about each error found.

Switching your Sage Construction Anywhere connection from version 19.7

If you were using Sage Construction Anywhere with Sage 100 Contractor version 19.7, and want to use it with version 20.2, you need to switch the connection from your version 19.7 company database to the version 20.2 database.

**NOTE:** These instructions assume that you do not intend to maintain a connection to both versions.

Your Sage Construction Anywhere site can connect to only one Sage 100 Contractor company data folder. If you want to connect Sage Construction Anywhere to version 19.7 and version 20.2, you must activate an additional site for your version 20.2 company data folder.

Before connecting Sage Construction Anywhere to Version 20.2:

1. Open the Sage Construction Anywhere Connector.
2. Make sure you have installed the latest build of Sage Construction Anywhere Connector (Build 2.10.20803.2).

   **TIP:** Look for the build number in the lower left corner of the Sage Construction Anywhere Connector screen.

3. Delete the connection to your version 19.7 company.
4. In the **Sage Construction Anywhere connections** box, select the company, and then click [Delete].

To create a new connection to version 20.2:

1. Open the Sage Construction Anywhere Connector, if it is not already open, and then:
   a. Click [Add].
   b. In the Select Back Office window, from the Back Office Product list, select **Sage 100 Contractor SQL**.
   c. Click [OK].
   d. In the Sage Construction Anywhere Connection Details window, enter new connection details for your version 20.2 company.
2. In your Sage Construction Anywhere website, generate a new connection key:
IMPORTANT: Important! You must be a Sage Construction Anywhere Site Administrator or have the Administrator Site permission to generate a connection key.

a. Click the Administration icon.
b. Select Back Office Connection.
c. Regenerate your connection key, select it, and then copy it to the clipboard.

3. In the Sage Construction Anywhere Connection Details window:
   a. Paste the connection key into the Connection key box.
   b. Click [Test connection] to make sure Sage Construction Anywhere is communicating correctly with your Sage Construction Anywhere company.
   c. Click [Save] to save your new connection.

4. In your Sage Construction Anywhere website, under All Lists, click [Request List] to request all lists.

When all the lists are refreshed, your Sage Construction Anywhere site will be updated with your version 20.2 data.

Migrating Sage ACT! settings from version 19.7

If you have been using Sage ACT! with Sage 100 Contractor version 19.7 and want to use it with the current version, you will need to change your ACT! settings to point to your new version 20.2 company database.

Before you migrate Act! settings

The steps in this section assume that you have:

- Set up Act! for version 19.7, and have created opportunities, and so on, in that program.
- Installed Sage 100 Contractor 2016 version 20.2.
- Migrated your Sage 100 Contractor data from version 19.7 to version 20.2.
- Reinstalled the Act! plugin.

To migrate Act! settings

1. Open Sage ACT!.
   The first time you open Act!, a message appears saying that the database is not initialized for use with Sage 100 Contractor SQL.
2. Click [Yes].
   A message appears saying that you will need to restart Act!
3. Click [OK].
   Once Act! has restarted, integration menu items appear at the bottom of the Tools menu.
4. Click Tools > Sage 100 Contractor Company Settings.
5. In the grid, select the Enable check box for the Version 20.2 company to which you want to migrate
Act! settings.

6. Click [OK].

7. Click Migrate Company Settings.

The Migrate V19 Company Settings window appears.

8. In the bottom grid, select the Version 19.7 company whose settings you want to migrate, and then click [Migrate].

After migration, all your opportunities and other settings from the version 19.7 company will be available in the current version.

**Migrating alerts from version 19.7**

Alerts are saved for Windows Task Scheduler on the machine they were created on. Therefore, you must use Sage 100 Contractor to migrate alerts created in version 19.7 to version 20.2 for individual workstations.

When you open the 7-6 Alerts Manager window, Sage 100 Contractor checks whether any alerts exist on that workstation for version 19.7. If it finds any, it displays a migration window that you can use to migrate these alerts to the current version. You can choose whether to take ownership of any alerts created for the Supervisor user, and you can choose to continue to run the alerts in version 19.7 as well as in version 20.2.

**NOTE:** After you have migrated all the alerts for the workstation and deleted them from version 19.7, the migration window is no longer available from the 7-6 Alerts Manager window.

**Before you start**

- Decide whether you want to continue to run alerts in Sage 100 Contractor version 19.7 after migrating them to version 20.2.
- Decide whether to take ownership of Supervisor alerts created in version 19.7.

**TIP:** If you have a large number of alerts, we suggest that you run Sage 100 Contractor as Administrator to avoid receiving a large number of Windows user access messages as you migrate the alerts. To run Sage 100 Contractor as administrator, right-click the Sage 100 Contractor icon on your Windows desktop, and then click Run as administrator.

**To migrate scheduled reports from version 19.7:**

1. Open 7-6 Alerts Manager.

   Sage 100 Contractor checks for alerts created in the Task Scheduler for version 19.7.

2. Click [OK] to close the message telling you that the program found alerts for version 19.7.

3. When the 7-6 Alerts Manager window opens, click the [Migrate] button that is available when there are version 19.7 alerts to migrate.

   The Previous Version Alerts window opens.

4. Use the Previous Version Alerts window to migrate alerts as follows:

   a. Select an option either to continue running the alerts in version 19.7 or to remove them all after migration.
b. If you want to take ownership of the Supervisor alerts, select the **Yes** option. Otherwise, accept **No**.

c. In the **Windows User Id** and **Windows password** fields, enter your Windows credentials.

d. Click [**OK**].

**Migrating scheduled reports from version 19.7**

Scheduled reports are saved in Windows Task Scheduler on the machine they were created on. Therefore, you must use Sage 100 Contractor to migrate tasks scheduled in version 19.7 for individual workstations.

When you open the **7-5 Scheduled Reports Manager** window, Sage 100 Contractor checks whether any scheduled reports exist on that workstation for version 19.7. If it finds any, it displays a migration window that you can use to migrate these scheduled reports to the current version. You can select which reports to migrate, and you can choose to continue to run those reports in version 19.7 as well as in the current version.

**NOTE:** After you have migrated all the scheduled reports for the workstation and removed them from version 19.7, the migration window is no longer available from the **7-5 Scheduled Reports Manager** window.

**Before you start**

Decide whether you want to continue to run scheduled reports in Sage 100 Contractor version 19.7 after migrating them to the current version.

**TIP:** If you have a large number of scheduled reports, we suggest that you run Sage 100 Contractor as Administrator to avoid receiving a large number of Windows user access messages as you migrate the reports. To run Sage 100 Contractor as administrator, right-click the Sage 100 Contractor icon on your Windows desktop, and then click **Run as administrator**.

**To migrate scheduled reports from version 19.7:**

1. Open **7-5 Scheduled Reports Manager**.

   Sage 100 Contractor checks for scheduled reports saved in the Task Scheduler for version 19.7.

2. Click [**OK**] to close the message telling you that the program found scheduled reports for version 19.7.

3. When the **7-5 Scheduled Reports Manager** window opens, click the [**Migrate**] button that is available when there are version 19.7 scheduled reports to migrate.

   The **Previous Version Schedule Reports** window opens.

4. Use the **Previous Version Schedule Reports** window to migrate reports as follows:

   a. In the **Migrate** column, select the check box beside the scheduled reports you want to migrate to the current version, or click [**Select All**].

   b. Select an option either to continue running the reports in version 19.7 or to remove them after migration.

   c. In the **Windows User Id** and **Windows password** fields, enter your Windows credentials.

   d. Click [**OK**].
Ready to “go live” with Sage 100 Contractor 2016?

This section provides an overview of all the important steps you should complete to "go live" with Sage 100 Contractor 2016. Read it carefully before you start using Sage 100 Contractor 2016 to process your data in a production environment (rather than in a test environment).

**TIP:** Download and print the "Going Live" Checklist from our website. Then check off each step on the printed list as you complete the necessary tasks.

**IMPORTANT:** Before using this version to process your current data, ensure that all Sage branded and third-party applications that you use with Sage 100 Contractor are compatible with this version, and that they can read and write to your version 20.2 database. (See step 9 for additional information.) Do not use Sage 100 Contractor 2016 with live data if you also use integrated products that are incompatible with version 20.2.

1. **Pick a “Go Live” Date**

With other stakeholders, decide on a go live date.

2. **Prepare your production (live) environment**

   - Upgrade to the latest build of Sage 100 Contractor 2016, or install it in your production environment.
   - Use Database Administration for Sage 100 Contractor to delete company data you migrated previously for testing in Sage 100 Contractor 2016.
   - Make sure that Sage Advisor Update is installed and working on each workstation that should receive updates. (When you install Sage 100 Contractor on a workstation, select the option to install Sage Advisor Update, and then make sure this icon appears in the system tray.)

3. **Migrate your company from version 19.7 for the last time**

Use Database Administration for Sage 100 Contractor to migrate your company to version 20.2.

If you have multiple companies, migrate your principal company first, and then go live with your other companies later.

   - Migrate your Sage 100 Contractor company folder.
   - Migrate your custom reports.
   - Migrate archive companies, as needed. (You can leave your archive companies in version 19.7 if you prefer.)

4. **Ensure that company administrators and sysadmin users have administrator rights on the server**

Make sure that users who will have company administrator or sysadmin rights in Sage 100 Contractor also have Windows administrator rights on the server that is hosting your SQL Server database.

**NOTE:** You may need to work with your IT department to accomplish this task.
5. Assign permissions to sysadmin users

Use the Database Administration tool to assign sysadmin rights to at least one other user.

6. Assign permissions to company administrators

In Sage 100 Contractor, use the 7-2-2 User List to designate former supervisor users as company administrators.

**TIP:** See the User List help for tips on copying Supervisor defaults from version 19.7 to company administrators in version 20.2.

7. Migrate alerts from version 19.7

In Sage 100 Contractor version 20.2, use the 7-6 Alerts Manager menu to migrate alerts from version 19.7.

**IMPORTANT:** Because alerts rely on Windows Task Scheduler, each user must migrate alerts they set up for version 19.7 on each workstation they will use. If alerts are set up to email users, users should make sure they receive the alerts in version 20.2, then delete the alerts from version 19.7 to avoid sending alerts twice.

8. Migrate scheduled reports from version 19.7

In Sage 100 Contractor version 20.2, use the 7-5 Reports menu to migrate scheduled reports from version 19.7.

**IMPORTANT:** Because scheduled reports rely on Windows Task Scheduler, each user must migrate reports they scheduled in version 19.7 on each workstation they use. Make sure that scheduled reports print in version 20.2, and then delete them from version 19.7 to prevent printing them in both versions.

9. Make sure integrated applications point to the v20.1 database

Ensure that all applications that read and write to your Sage 100 Contractor database now read and write to your SQL Server database. You may need to obtain instructions on pointing third-party applications to your version 20.2 database from your business partner.

- **Sage Construction Anywhere.** See Knowledgebase article 70063 for more information.
- **Sage ACT!** See Knowledgebase article 70064 for more information.
- **Sage Service Operations.** Although a compatible version is expected soon, you should not "go live" until it is available. See Knowledgebase article 60066 for more information.
- **Sage Paperless.** Although a compatible version is expected soon, you should not "go live" until it is available. See Knowledgebase article 60065 for more information.
- **Sage Intelligence Reporting.** Although a compatible version is expected soon, you should not "go live" until it is available.
- **Other third-party applications.**
10. Stop using version 19.7

- In version 19.7, remove users from the 7-3-2 User List to prevent accidental use of the version 19.7 company.
- Rename the version 19.7 company folder to ensure that it is not accidentally migrated again. Use the format CompanyNameMigratedMMDDYY so that users and Customer Support can easily determine that the data was migrated on, say, July 31, 2016.

11. After going live

Test your EFT data, if you used EFT in version 19.7, to ensure that you can create an EFT file with the same data as in version 19.7.

Uninstalling Sage 100 Contractor from a Sage license server

When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are deauthorized and made available to be acquired by another license server. If the Sage license server crashes and the licenses are not deauthorized, contact Customer Support to have the licenses unlocked.

If uninstalling and then reinstalling to a Sage license server, the licenses need to be reactivated after reinstallation.
Chapter 4: Act! Plug-in Installation

This chapter provides information and instructions for installing the Act! plug-in for use with Sage 100 Contractor.

Pre-installation information

These instructions assume that you are integrating ACT! with an installation of Sage 100 Contractor 2016, or later.

Before you can integrate Sage 100 Contractor with ACT!, you must also:

- Install Act! Premium or Act! PRO (version 2011 or later).
- Obtain an Act! plug-in license use.

Duration of the installation process

Plan on at least five to ten minutes per computer to install the Act! plug-in. The duration of the Sage 100 Contractor installation depends a great deal upon each computer's configuration. Installation to older computers may take more time.

Additional required software

Act! Premium or Act! PRO (version 2011 or later) must be installed on all computers running Sage 100 Contractor software that use the Act! plug-in.

Plan for an additional 10 to 15 minutes per computer to install Act! Premium or Act! PRO.

NOTE: It is very important that you understand the network environments and operating systems on the computers and server computers where you install Sage 100 Contractor software. "Chapter 8: Special Configurations—Operating Systems and Services" provides detailed information about installing to different environments.

Installing the Act! Plug-in

Basic steps for installation are:

1. Verify Sage 100 Contractor and Act! Premium or Act! Pro (version 2011 and later) are already installed.
3. Install the Act! plug-in on any client workstations where you use Act!.

Installation of Sage 100 Contractor and Act!

To install Sage 100 Contractor, refer to “Chapter 3: Sage 100 Contractor Installation” in this guide.
To install Act!, refer to the installation instructions that came with Act! Premium or Act! PRO (version 2011 or later) and see the Act! Getting Started Resource Center at http://na.sage.com/Sage-ACT/support/Getting-Started.

**Activate your Act! plug-in license use**

To activate your Act! plug-in license, refer to "Chapter 6: Managing Your License" in this guide.

**To install the Act! plug-in on client workstations:**

1. Close all open programs except for firewall and antivirus programs.
2. Browse to the drive containing Sage 100 Contractor (for example, Programs (x86) > Sage > Sage 100 Contractor SQL).
3. Double-click ACTPluginSetup.exe to begin the installation.
4. On the welcome window, click [Next].
5. On the Installation complete window, click [Finish].
6. Restart your computer as necessary.
Chapter 5: Sage Construction Anywhere Installation

This chapter provides information about setting up Sage 100 Contractor for use with Sage Construction Anywhere.

Additional required software

- The Sage Construction Anywhere Connector should be installed on at least one computer running Sage 100 Contractor software that connect to Sage Construction Anywhere, but can also be installed to a separate server. The Sage Construction Anywhere Connector connects your back office software to your Sage Construction Anywhere site. The connector installation includes the Sage Construction Anywhere Connector software and its required prerequisite software.

- An Internet connection using a compatible web browser. See "Appendix A: System Requirements" for supported browsers in the Getting Started Guide.

**NOTE:** A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.

For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at

Duration of the installation process

Plan on at least five to ten minutes per computer to install the Sage Construction Anywhere Connector software. The duration of the Sage 100 Contractor installation depends a great deal upon each computer's configuration. Installation to older computers may take more time.

Pre-installation information

To integrate Sage 100 Contractor with Sage Construction Anywhere, you must install and set up supported versions of the following programs:

- Sage 100 Contractor
- Sage Construction Anywhere

For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at

**NOTE:** A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.
Setting up Sage Construction Anywhere Integration

To integrate Sage 100 Contractor with Sage Construction Anywhere, you must first install and set up the following programs:

- Sage 100 Contractor 2016 version 20.2
- The most recent build of Sage Construction Anywhere

In addition, an API user needs to be set up for any companies that are to be integrated.

- In Sage 100 Contractor, in 7-2-1 Security Groups, an API security group must exist with the appropriate save permissions. See “Setting up an API security group and an API user in Sage 100 Contractor” below to set up the API group.
- In Sage 100 Contractor, in 7-2-2 User List, a user that is a member of the API group must be set up.

Setting up an API security group and an API user in Sage 100 Contractor

Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-2-1 Security Groups window in Sage 100 Contractor contains a grid with numbered rows on the left and eight columns:

- Group# (User input is required to save the record.)
- Group Name (User input is required to save the record.)
- Save
- Delete
- Void
- Chg Period
- Print Cheques
- Notes

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will have rights to Save, Delete, and Void records, as well as to change the accounting period and print cheques. You may use the Notes column to add any pertinent information about each group.

You must create an API security group that is named exactly API. At least one user must be added to the API security group. You have to set rights to save, void, and so on.

**IMPORTANT:** If you use security groups for the tasks performed by the employee in Sage 100 Contractor, make sure the Sage Construction Anywhere user has access to all areas of Sage 100 Contractor.
To set up a security group for using the API

1. Open 7-2-1 Security Groups.
2. In the Group# cell, type a group number, such as 51.
3. In the Group Name cell, type API and do the following:
   
   **IMPORTANT:** The API security group must be named exactly API.
   
   a. In the Save, Delete, Void, Chg Period, and Print Cheques cells, type Yes.
   b. To store information that may be relevant or important to that specific group, type a note in the Notes cell.
4. On the File menu, click Save.

**TIPS:**

- Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a user to the API security group.
- Security is set up for each individual company, not for the entire program. Each company can use different user names and passwords. If you have more than one company, you have to set up passwords for multiple companies.

Then you have to assign a user to the API security group using 7-2-2 User List.

The 7-2-2 User List window controls major features dealing with users and program security.

**NOTE:** The user name and password created are for administrative use only. This information is for use by the Sage Construction Anywhere Connector program only, and is not needed by the individual employee(s) using Sage Construction Anywhere.

To assign a new user to the API security group

1. Open 7-2-2 User List.
2. In the User Name cell, enter a user name, such as SCAUser.
3. In the Password cell, enter a password.
4. In the Group 1 cell, click once in the cell, and from the drop-down list, select the API group.
5. Click File > Save.

To assign an existing user to the API security group

1. Open 7-2-2 User List.
2. Find the User Name for the person who will use Sage Construction Anywhere.
3. In the Group 1, Group 2, Group 3, Group 4, or Group 5 cell, click once in the cell, and from the drop-down list, select the API group.
4. Click File > Save.
Chapter 6: Managing Your License

This chapter provides detailed information about:

- Managing and activating your license
- Using License Administration

License administration

When you purchase Sage 100 Contractor software, it includes the License Administration program. Using the License Administration program, you can activate licenses and monitor the license uses. During software installation, the License Administration program is automatically installed on the computer that the software installer designates as the Sage license server.

**IMPORTANT:** Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network that is the Sage license server when you launch Sage 100 Contractor.

**Where is the Sage license server located?**

The Sage license server is software running on a computer on your network that manages the Sage 100 Contractor products and features that you purchased. Products and features can be a "core product," additional "modules," and a number of "license uses." The computers running your Sage 100 Contractor have to be connected to the computer running the Sage license server so that the correct products, features, and number of license uses are available to you.

License Administration tool

**License Administration window**

Use the License Administration window to view and maintain your licensing information, which includes:

- The number of license uses.
- The users who are logged on to Sage 100 Contractor.
- Licensing events.

The licenses give you access to the various modules of Sage 100 Contractor.

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. As you purchase or remove license activations, the Sage license server automatically updates this information in your system. You can also update the licensing information from Sage on demand.

**About managing licenses**

Use the License Administration window to activate licenses and monitor license uses.

**Activating licenses**

In order to use Sage 100 Contractor, you have to activate your product licenses.
To activate your license:

1. On the License Administration window, click the **Edit registration info** link.
2. Enter your **Sage client ID**.
3. Enter your **Registration name**.
4. Click **[OK]**.

**License Information tab**

The tab, which is available from the **License Administration window**, displays information about your Sage 100 Contractor licenses.

**Items on this tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support plan expiration date</td>
<td>The date on which your support plan with Sage Customer Support expires.</td>
</tr>
<tr>
<td>Number of requests which exceeded use count (last 90 days)</td>
<td>Displays the number of times the request for licenses failed in the past three months because there were not enough licenses available. If there are a significant number of requests, you may want to acquire additional licenses.</td>
</tr>
<tr>
<td>Last license information update</td>
<td>The last date upon which your licenses were verified with Sage’s license server.</td>
</tr>
</tbody>
</table>

**NOTE:** If your system cannot connect to Sage for a period of more than 10 days, you will receive a message indicating there is a connection problem. See **Troubleshooting license activation issues** for more information.
<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Licensed modules            | Displays a list of licenses available to this server, based on the products you have purchased from Sage. When you purchase new products, the licenses for those products become available to activate here. "Canadian Edition" refers to the basic program, exclusive of the additional modules. The module licenses that are not part of the core Canadian Edition, but are available for purchase, are listed here:  
  - Inventory  
  - Service Receivables  
  - Estimating  
  - Document Control  
  - Equipment Management  
  There is also a column that shows how many Canadian Edition licenses are checked out from this license server to local machines. |
| Update license information  | Click to update the license information manually. This connects your server to the Sage license server, where your current license information is stored, and it updates the information on this window. This also creates entries in the event log. View the event log to monitor the success of your license activations.  
  **NOTE:** If you are using multi-server license administration, ensure you have the proper allocations set under Multi-server licensing before you update your license information. |
| Deauthorize license server  | Typically, this would be used if you are moving Sage 100 Contractor's license server from one machine to another machine.  
  **IMPORTANT:** You need to deauthorize the old server in the License Information tab before you authorize Sage 100 Contractor's license server on a new server. |
| Multi-server licensing      | This allows you to allocate your Sage licenses to multiple servers. For example, this could happen if you have several corporate offices and want to use separate licenses for each office or if you want to reserve a certain quantity of license uses for a specific group of people. |

**Active Users tab**

This tab of the License Administration window lists the names of all users and computers currently using Sage 100 Contractor.

Each row in the list represents a separate license use. If you find you are running out of licenses, you can review this list to determine if any licenses can be made available. To make a license available, simply close Sage 100 Contractor on one of the computers where the program is running.

You can restrict all users from logging on to the Sage 100 Contractor software from this tab.
Chapter 6: Managing Your License

Items on this tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The name of the user who is currently logged on to Sage 100 Contractor.</td>
</tr>
<tr>
<td>Computer</td>
<td>The computer where the user is logged on to Sage 100 Contractor.</td>
</tr>
<tr>
<td>Session</td>
<td>The Windows session for the user.</td>
</tr>
<tr>
<td>Restrict logon/Allow logon</td>
<td>Click Restrict logon to prevent users from logging on to Sage 100 Contractor temporarily. This prevents new users from logging on to Sage 100 Contractor but does not remove existing users. You might use this feature in preparation for backing up your database, for example. If you have previously restricted logon, click Allow logon to allow users to log on to Sage 100 Contractor.</td>
</tr>
</tbody>
</table>

Event log tab

Use this tab of the License Administration window to view events related to licensing. This lists whether license validation was successful or if there were any problems attempting to validate the licenses. See Troubleshooting license activation issues for more information about issues validating licenses.

Items on this tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>The level of the licensing event (for example, informational).</td>
</tr>
<tr>
<td>Date and time</td>
<td>The date and time that the licensing event occurred.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the licensing event. Typically, this displays &quot;Entitlements updated for client,&quot; but this will also indicate if there was a problem updating the licenses. The section below this area provides additional details about the issue.</td>
</tr>
<tr>
<td>Clear event log</td>
<td>Click to remove all entries in the list.</td>
</tr>
</tbody>
</table>

Maintaining license information

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license server automatically updates this information in your system. You can also select to update the licensing information manually.

NOTE: Licenses are granted to the specific computer where the licenses were initially activated. If you need to move your Sage 100 Contractor server to a different server, you must first deactivate the licenses in the License Information tab on the old server before you can activate them on a new server.
To view or change license information:

1. Select License Administration program.
2. You can view or change the information here, or you can click Update license information to retrieve current licensing information from Sage. Note that the Sage client ID and Registration name must match Sage's records exactly in order for the update to be successful. To change the Sage client ID or the registration name, select Edit registration information.

**NOTE:** If you have multiple servers serving your Sage 100 Contractor application, click Multi-Server License Administration to allocate and update your licenses.

3. To view which users are logged on to Sage 100 Contractor, click the Active users tab.
4. To view the results of the previous update attempts, click Event log. Click Clear event log if you no longer need the information.

**TIP:** For more information, click ![Information Icon] while viewing the window.

### Multi-Server License Administration window

For most users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers.

If you need to allocate licenses across multiple servers, this window allows you to allocate your Sage licenses to multiple servers—for example, if you have several corporate offices and want to use separate licenses for each office, or if you want to reserve a certain quantity of licenses for a specific group of people.

Because the Canadian Edition license controls the amount of license uses, it is the only license which is “use-counted.” Therefore the only license that is allocated among multiple servers is the Canadian Edition license. The additional modules are not use-based and can be used by anyone with a core Canadian Edition license and the appropriate security permission.

#### Example 1—Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:

<table>
<thead>
<tr>
<th>Server</th>
<th>Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server A</td>
<td>3 Canadian Edition licenses</td>
</tr>
<tr>
<td>Server B</td>
<td>3 Canadian Edition licenses</td>
</tr>
<tr>
<td>Server C</td>
<td>4 Canadian Edition licenses</td>
</tr>
</tbody>
</table>

At each of the servers, you would select the Manually specify allocations for this server option in the Multi-Server License Administration window, and select the number of licenses for that server.

If you later purchase additional Canadian Edition licenses, you must go into each server where you want the additional licenses to be allocated and update the allocation.

#### Example 2—Multiple servers with specific allocations for all but one server

Assume you have three servers that you want to allocate as follows:
At servers A and B, select the **Manually specify allocations for this server** option in the Multi-Server License Administration window, and select the number of licenses for each server.

At server C, select the **Allocate all available licenses to this server** option in the Multi-Server License Administration window.

**NOTE:** In this example, it is important to select the option for server C last. If you select to automatically allocate all available licenses on server C first, it will take all the available licenses and there will be none left to allocate to servers A and B.

If you purchase additional licenses, they will automatically be allocated to server C when the license activations are updated, unless you manually select the licenses to go to server A or B first.

**Items on this window**

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate all available licenses to this server (default)</td>
<td>If you choose this option, all licenses are allocated to this server. This is the most common scenario. Do not choose this option if you want to allocate licenses across multiple servers.</td>
</tr>
<tr>
<td>Manually specify license allocations for this server in the &quot;Uses for [server name]&quot; column below</td>
<td>Select this option to allocate licenses across multiple servers. The amount of licenses you select in the <strong>Uses for [server name]</strong> column is the amount of licenses allocated to this server.</td>
</tr>
</tbody>
</table>
### Module name

Displays a list of licenses available to this server, based on the products you have purchased from Sage. When you purchase new products, the licenses for those products become available to activate here. "Canadian Edition" refers to the basic program, exclusive of the additional modules. The module licenses that are not part of the core Canadian Edition, but are available for purchase, are listed here:

- Inventory
- Service Receivables
- Estimating
- Document Control
- Equipment Management

There is also a column that shows how many Canadian Edition licenses are checked out from this license server to local machines.

### Total uses

The total number of uses that are available. This displays the total number of licenses you have purchased.

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available uses</td>
<td>The number of uses available to this server. If some licenses have already been allocated to a different server, it reduces the number of uses available here. For example, if you have 10 total uses, and 2 have been allocated to another server, the available uses for this server is 8.</td>
</tr>
<tr>
<td>Uses for [server name]</td>
<td>The number of uses allocated to this server. You can change the number here, but you can only add uses if there are still uses available. You can decrease uses to make more licenses available to other servers. If you need to have more uses available to this server, you must first relinquish licenses on one of your other servers, or purchase additional licenses.</td>
</tr>
<tr>
<td>[OK]</td>
<td>Click to allocate the licenses selected in the Uses for [server name] column to this server.</td>
</tr>
<tr>
<td>[Cancel]</td>
<td>Click to cancel this window without making any changes.</td>
</tr>
</tbody>
</table>

To open this window, open the License Administration program and on the License Information tab, click [Multi-server licensing].
Managing licenses

Checking out and checking in a license use

You can use Sage 100 Contractor when your computer cannot actively communicate with the license server, by checking out a license use from the Sage license server.

NOTE: Checking out a product license use removes it from the license server’s pool of generally available license uses and places it directly on the computer checking out the license. However, this may prevent other user access to Sage 100 Contractor, so checking out a license should only be used when necessary.

To check out a license use:

1. From the Sage 100 Contractor main window, on the File menu, click Check Out License Use.
2. Click Yes.

IMPORTANT: If you check out a license use, it remains checked out on this computer until you check in the license using Check In License Use from the File menu.

To check in a license use:

1. From the Sage 100 Contractor main window, on the File menu, click Check In License Use.
2. Click Yes.

Administering a different license server

In the License Administration program, you can see the number of license uses, the users who are logged on to Sage 100 Contractor, and licensing events for this license server.

Licenses are granted to the specific computer where the licenses were initially activated. If you need to see the license uses available on another Sage license server, you can do that in the License Administration window.

To administer a different license server:

1. Select the License Administration program.
2. From the License Administration window, click Administer Different Server.
3. Enter computer name or IP address. How?

Troubleshooting license issues

Troubleshooting license activation issues

Your system will automatically retrieve license information from Sage daily. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage
license activation server automatically updates this information in your system.

If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 10 days, you will receive a message indicating there is a connection problem. The following are some of the more common issues that can cause this to occur.

**There is a problem with your Internet connection.**

The Sage 100 Contractor server connects to the Sage license server through the Internet. Check to make sure the server's connection to the Internet is intact.

**There is a problem with your network.**

Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 100 Contractor server from connecting to the Sage license server. Confirm that your firewall is configured correctly and that all network components are operating properly.

**The registration information does not match.**

The Sage client ID and Registration Name on the License Administration window must match the information on the Sage license server. Ensure the information is entered correctly here.

**You have exceeded your license activations.**

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. You may want to purchase more licenses.

**TIP:** The Number of requests which exceeded use count box on the License information tab of the License Administration window displays the number of times in the last three months that requests for licenses have exceeded the number of licenses available.
Chapter 7: License Use and Sage 100 Contractor

This chapter provides all the necessary details about:

- Specifying the Sage license server
- Managing license attributes
- Understanding license uses

Specify Sage License Server

What is a server?

There are many kinds of servers. Some servers are denoted by their hardware configuration and a specialized operating system. Other servers consist of specialized software applications running on standard computers.

Some servers are called “file servers” and may be a powerful computer dedicated to storing files and data. For example, Sage 100 Contractor company data can be stored on a file server. Any Sage 100 Contractor user on the same network as the file server can access and store data there.

A server can also be a software application that provides a specific kind of service to client software running on other computers. The term server can refer to a particular piece of software, such as the Sage license server. When we refer to the Sage license server, we are describing a computer that is running the Sage license server software.

Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network that is the Sage license server. There are two ways to specify the Sage license server:

- You can select the computer from the list of computers on your network; or
- You can enter the IP Address or name of the computer.

Selecting the Sage license server computer

One method is to select the computer running the Sage license server from the list of network computers.

**NOTE:** To use this method of selecting a server from the list of network computers, you must have already clicked the appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:

1. On the Select License Server window from the list of network computers, select the computer running the Sage license server.
2. Click [OK].
Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running the Sage license server.

To enter the IP Address or name of the computer running the Sage license server:

1. In the text box, type the IP Address or name of the computer.
2. Click [OK].

What is an IP Address?

Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) address. This numeric address of a computer on the Internet is written as a set of four numbers separated by periods (each number can range from 0 to 255). An example of an IP Address is 123.123.4.5.

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, you must complete this procedure on that computer.

To determine the IP Address of a computer:

1. Click Start > Run.
2. In the Open text box, type cmd, and then click [OK].
   The \Windows\...\cmd.exe window appears.
3. At the prompt, type ipconfig.
   For example, you might see H:\. Type ipconfig after the drive letter.
4. Press the [Enter] key.
   The system displays several addresses including the IP Address of the computer, similar to this line:
   
   IP Address . . . . . . . . . . .172.20.22.142

Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the license server, you must complete this procedure on that computer.

To determine the name of a computer:

1. On your Windows desktop, click Start > Settings> Control Panel.
2. From the list, scroll to and then double-click System.
   The System Properties window appears.
3. Locate the line Full computer name, and then make a note of the name.
4. Click [Cancel].
Chapter 8: Special Configurations—Operating Systems and Services

This chapter contains information about special configurations for specific operating systems, such as:

- Windows® 8.1 Professional and Server 2012 Standard
- Windows 7 Professional and Windows Server 2008® R2 Standard
- Windows Server 2008
- Citrix® and Terminal Servers

Windows 8.1 Professional and Server 2012 Standard Operating Systems

Windows 8.1 Professional and Server 2012 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 8.1 Professional or Server 2012 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can't obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8.1

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2012, follow these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click Explore.
2. On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under **Group or User Names**, select **USERS**, and then click [**Edit**].

5. On the **Permissions** window, select **USERS** again, and under **Allow**, select the **Full control** check box.

   (Selecting **Full control** selects all the check boxes necessary for this solution.)

6. On the **Permissions** window, click [**OK**].

7. On the **MB7 Properties** window, click [**OK**].

---

**Server 2012 network configuration and TCP Remoting Channel**

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

**Windows 7 Professional and Server 2008 R2 Standard Operating Systems**

Windows 7 Professional, Windows 8.1 Professional, and Server 2008 R2 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional, Windows 8.1, or Server 2008 R2 Standard operating system is used as a license server, when it goes into sleep mode, other computers on the network can’t obtain a license.

Set **Sleep Mode** on your license server computer to **Never**.

**To set the Sleep Mode to “Never”:**

1. **Start > Control Panel > System and Security > Power Options.**
2. Select **Change when computer sleeps**.
3. From the **Put computer to sleep** list, select **Never**.

**Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 7 Professional and Server 2008 R2 Standard**

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

**Solution for Server 2008 R2 error message about mb7.kpr file**

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2008 R2, follow these steps to resolve the issue:
1. On the Window desktop, right-click **Start**, and then click **Open Windows Explorer**.

2. On the left side of the window, under **Computer > Local Disk**, right-click the `\MB7` folder, and then select **Properties**.

3. On the **MB7 Properties** window, click the **Security** tab.

4. From the list under **Group or User Names**, select **USERS**, then click the [**Edit**] button.

5. On the **Permissions** window, select **USERS** again, and under **Allow**, select the **Full control** check box.

   Selecting **Full control**, selects all the check boxes necessary for this solution.

6. On the **Permissions** window, click [**OK**], and then on the **MB7 Properties** window, click [**OK**].

**Server 2008 R2 network configuration and TCP Remoting Channel**

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2008 R2 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2008 R2 Help.

**Windows Server 2008 R2 and Microsoft .NET 3.5.1**

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn't install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [**OK**], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

**To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:**

1. Click the **Start** button in the lower left corner of the display.

2. Highlight **Administrative Tools** and select **Server Manager**.

3. In the **Server Manager** interface, click **Features** to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.

**To enable .NET 3.5.1 on Windows Server 2008 R2:**

1. In the **Server Manager** interface, select **Add Features** to display a list of possible features.

2. In the **Select Features** interface, expand **.NET Framework 3.5.1 Features**.

3. Once you expand **.NET Framework 3.5.1 Features**, you will see two check boxes. Check the box next to **.NET Framework 3.5.1** and click **Next**.
4. In the **Confirm Installation Selections** interface, review the selections and then click [Install].

5. Allow the installation process to complete and then click [Close].

**NOTE:** Enabling .NET Framework 3.5.1 may require a reboot.

### Windows 7 and Server 2008 Operating Systems

**Server 2008 “Sleep Mode” prevents computers from obtaining a license use**

If you are using a Server 2008 computer as the Sage license server and it goes into **Sleep Mode**, the workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in place of Server 2008.

Set **Sleep Mode** on your license server computer to **Never**.

**To set the Sleep Mode to "Never":**

2. Select **Change when computer sleeps**.
3. From the **Put computer to sleep** list, select **Never**.

**Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 7, Windows 8.1, or Server 2008**

**IMPORTANT:** Read this information if you are running Windows 7, Windows 8.1, or Server 2008 operating systems on your office computers.

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 7, Windows 8.1, or Server 2008 operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

**Solution for Server 2008 error message about mb7.kpr file**

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2008, follow these steps to resolve the issue:

1. On the Window desktop, right-click **Start**, and then click **Explore**.
2. On the left side of the window, under **Folders**, right-click the **MB7** folder, and then select **Properties**.
3. On the **MB7 Properties** window, click the **Security** tab.
4. From the list under **Group or User Names**, select **USERS**, then click [Edit].
5. On the **Permissions** window, select **USERS** again, and under Allow, select the **Full control** check box.
Selecting **Full control** selects all the check boxes necessary for this solution.

6. On the **Permissions** window, click [**OK**], and then on the **MB7 Properties** window, click [**OK**].

**Windows 7 and Server 2008 network configuration and TCP Remoting Channel**

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File sharing on computers running the Windows 7 or Server 2008 operating system must be enabled.

To enable file sharing, follow the instructions in the Windows 7 or Server 2008 Help.

**Windows 7 and Server 2008 and changing the Sage License Server computer**

On a Windows 7 or Server 2008 workstation, when you select **File > Change Sage License Server > Select the computer from the list of computers on your network**, the command may fail to generate a list of network computer names.

To resolve this issue, click **Enter the IP address or name of the computer**, and then type the IP address of the server computer in the box.

**Citrix and Terminal Servers**

**Using Citrix and Terminal Server with Sage 100 Contractor**

Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If Sage 100 Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then you may log on to the computer running Citrix or Terminal Server with your laptop and work in Sage 100 Contractor on your LAN. This enables you to work from home, from a job site, or from any number of other remote locations.

We recommend that you use DOS commands to change the operating mode from “execute” to “install” and then back to “execute.” When using the DOS commands to install, you may install the Sage 100 Contractor software as you would on any desktop or Windows server operating system that meets Sage 100 Contractor requirements.

**Installing on computers running Citrix and Terminal Server using DOS commands**

To install using DOS commands:

1. Click [**Start**] > **Run**.
2. On the **Run** window:
a. In the **Open** drop-down box, type `cmd`.

b. Press `[Enter]`.

The `\Windows\...\cmd.exe` window appears.

3. When prompted, type `change user /install`, and then press `[Enter]` to turn on the Install mode.

4. Install Sage 100 Contractor as you would on a typical workstation or Windows Server.

5. At the end of the installation process, launch the **License Administration** program.

6. Use the License Administration window to activate and manage your license.

7. After activation, click **Start > Run**.

8. On the Run window, in the Open drop-down box, type `cmd`, and then press `[Enter]`.

The `\Windows\...\cmd.exe` window appears.

9. When prompted, type `change user /execute` to turn on the Execute mode, the default mode for running Citrix and Terminal Server.

10. Exit the **Run** window.

11. Restart the server.

**IMPORTANT:** If this message appears: "Install mode does not apply to a terminal server configured for remote administration," it is not necessary to turn on the install mode. You may install the Sage 100 Contractor software as you would on a typical workstation.

### Backing Up Your Data

With any computer system, there is the possibility for failure and loss of data.

Database Administration for Sage 100 Contractor includes a utility for backing up your company data to a network location or a local folder. (The default location is `C:\Users\Public\Documents\Sage\100CSQL\Backup\On Demand`.) These routine backups take place during nightly maintenance according to a schedule that you (as a company administrator) specify. You also specify the number of backup copies to keep.

You should also store at least one copy of your backed-up data off premises or in a fireproof safe. If a burglary or fire occurs, a copy of your data is safe from harm.

**CAUTION:** Always use Database Administration to back up your data. Database Administration backs up numerous files (including external files, such as attachments) that are not part of the SQL database, and it performs additional steps to ensure that you can successfully restore your data from a backup copy. Do not attempt to back up Sage 100 Contractor data using Microsoft SQL Server Management Studio or other third-party software, or you will be unable to restore the company.

For more information about backing up and restoring your data, see the **Database and Company Administration Guide**.
Copying your data to a CD or DVD

Sage 100 Contractor automatically backs up your data to a server location and according to the maintenance schedule specified for your company. You can also back up your data at any time using the backup function in Database Administration.

**IMPORTANT:** We recommend that you routinely store backed-up copies of your data in a safe environment that is separate from your server, preferably off site. This topic suggests a way to copy your backed-up data to a CD or DVD for offsite storage.

**To copy your data to a CD or DVD**

1. On your server machine, place the CD or DVD media in the CD or DVD drive.
3. In Windows Explorer:
   a. Locate the C:\Sage100Con\Backup\On Demand folder.
   b. In the On Demand folder, right-click the backup that you want to copy.
   c. From the menu, click Copy.
4. Locate and then click the CD or DVD drive.
5. In the right-pane, right-click and then select [Paste].

Depending on your hardware and software, the backup is copied to the CD or DVD media. For further information or support, contact your CD or DVD manufacturer.

Configuring Windows Regional and Short Date Format

**To specify regional formats for Windows:**

1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under Date and time formats, from the Short date format drop-down list, select the format used for your country.
5. Click [OK].
6. Close the Clock, Language, and Region window.
Index

... document conventions 1
DOS cmd installation
  Citrix servers 61
  Terminal servers 61

F
fax service component
  Windows 15
firewall
  configure 9
forms
  cheque 5
  tax 5

H
Help 5

I
install 19-20, 23, 26, 39, 41
  duration 20, 39, 41
  installing on client workstations 26
  installing the Sample Company 23
  pre-installation for existing customers 19
  pre-installation for new customers 19
installing
  ACT plug-in on client workstations 39
  installing .Net Framework 21
integration
  Sage Construction Anywhere 42
<table>
<thead>
<tr>
<th>Ip Address</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>what is an IPAddress</td>
<td>operating system</td>
</tr>
<tr>
<td>IP Address</td>
<td>port numbers</td>
</tr>
<tr>
<td>determining the IPAddress</td>
<td>TCP Remoting Channel</td>
</tr>
<tr>
<td>entering the IPAddress</td>
<td>reports</td>
</tr>
<tr>
<td></td>
<td>faxing and emailing</td>
</tr>
<tr>
<td></td>
<td>setup</td>
</tr>
<tr>
<td>L</td>
<td>S</td>
</tr>
<tr>
<td>language</td>
<td>Sage 100 Contractor Hosting Framework</td>
</tr>
<tr>
<td>License Administration</td>
<td>autostart 57-58, 60</td>
</tr>
<tr>
<td>license server</td>
<td>Sage Construction Anywhere 42</td>
</tr>
<tr>
<td>change server computer</td>
<td>setting up integration 42</td>
</tr>
<tr>
<td>licenses</td>
<td>setting up the API security group 42</td>
</tr>
<tr>
<td>activating licenses</td>
<td>setting up the API user and password 42</td>
</tr>
<tr>
<td>licensing</td>
<td>Sage CRE</td>
</tr>
<tr>
<td>TCP Remoting Channel</td>
<td>cheques 5</td>
</tr>
<tr>
<td></td>
<td>forms 5</td>
</tr>
<tr>
<td>M</td>
<td>Sage license server 24, 45, 55</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>installing the Sage license server 24</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>managing licenses 45</td>
</tr>
<tr>
<td></td>
<td>name 56</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td><strong>selecting server computer</strong></td>
<td>55</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----</td>
</tr>
<tr>
<td>Sample Company</td>
<td>23</td>
</tr>
<tr>
<td>installing</td>
<td>23</td>
</tr>
<tr>
<td>server</td>
<td>55</td>
</tr>
<tr>
<td>Server 2008</td>
<td></td>
</tr>
<tr>
<td>change license server</td>
<td>61</td>
</tr>
<tr>
<td>sleep mode</td>
<td>60</td>
</tr>
<tr>
<td>TCP Remoting Channel</td>
<td>8</td>
</tr>
<tr>
<td>Server 2008 R2</td>
<td></td>
</tr>
<tr>
<td>sleep mode</td>
<td>57-58</td>
</tr>
<tr>
<td>TCP Remoting Channel</td>
<td>59</td>
</tr>
<tr>
<td>Server 2012</td>
<td></td>
</tr>
<tr>
<td>TCP Remoting Channel</td>
<td>58</td>
</tr>
<tr>
<td>simple mail transfer protocol</td>
<td>14</td>
</tr>
<tr>
<td>sleep mode</td>
<td></td>
</tr>
<tr>
<td>Server 2008</td>
<td>60</td>
</tr>
<tr>
<td>Server 2008 R2</td>
<td>57-58</td>
</tr>
<tr>
<td>Windows 7</td>
<td>57-58</td>
</tr>
<tr>
<td>SMTP</td>
<td>14</td>
</tr>
<tr>
<td>software</td>
<td>21, 39, 41</td>
</tr>
<tr>
<td>additional required software</td>
<td>21, 39, 41</td>
</tr>
<tr>
<td>special configuration</td>
<td></td>
</tr>
<tr>
<td>Windows 7/Server 2008 R2</td>
<td></td>
</tr>
<tr>
<td>autostart</td>
<td>57-58</td>
</tr>
<tr>
<td>system configuration</td>
<td></td>
</tr>
<tr>
<td>language and date</td>
<td>63</td>
</tr>
</tbody>
</table>

| **TCP Remoting Channel**    |      |
| licensing                   | 8   |
| port numbers                | 9   |
| Terminal servers            | 61  |
| DOS cmd installation        | 61  |
| The Users Group (TUG)       | 5   |
| training                    | 4   |
| getting started             | 4   |
| TUG (The Users Group)       | 5   |
| upgrade                     | 28  |
| installing the upgrade      | 28  |
| Vista                       |      |
| change license server       | 61  |
| Windows                     |      |
| fax service component       | 15  |
| regional and short date     | 63  |
| Windows 7                   |      |
| sleep mode                  | 57-58|
| autostart                   | 57-58|
| language and date           | 63  |